
                                                                              Getting Started

Page 73

The following table lists the folders that are created within Projects:

Folder Name Type of information stored in the folder

Acqudb Acquisition defaults and saved tune page settings, calibrations
etc.  Inlet method files.

Curvedb Quantify calibration curve data.

Data Raw data files.

Peakdb Peak list data.

Methdb Method files.

Sampledb Sample Lists.

Data File Structure

Data acquired from the mass spectrometer is saved into data files on the computer’s
hard disk.  These data files may contain more than one acquisition function and
may also contain processed data derived from the original raw data, for example
refined spectra.

All files are acquired to the data directory of the current project

For example if the file name is specified as test2 then the data files are stored in
the directory c:\MassLynx\currentproject\data\test2.  If the data file contains 2
acquisition functions and 2 sets of processed data then the directory listing will be
as follows:

_Header.txt Data file header information

_Funcs.inf Information on functions acquired

_history.inf Information on how data has been processed

_expment.inf Experimental record information.

_Func001.dat Data file for first function (one for each function)

_Func001.idx Data file index for first function

_Func002.dat Data file for second function

_Func002.idx Data file index for second function

_proc001.dat First processed data file (one for each process)

_proc001.idx Index for first processed data file

_proc002.dat Second processed data file

_proc002.idx Index for second processed data file
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Displaying Spectra

There are several ways in which you can display the Spectrum window.

n To select a Spectrum using the MassLynx menu

Choose Spectrum from the View menu or press the  toolbar button.  The
spectrum displayed will be the current default spectrum (this will be either the last
spectrum viewed, or if acquisition is in progress the last spectrum acquired).  If the
Spectrum window is already on display, it becomes the current window.

n To select Spectra using the Sample List

If whole rows are selected in the Sample List editor, Spectra from the data files
represented by these rows will be displayed.

n To select a Spectrum from Chromatogram

Double click on the chromatogram at the retention time in which you are
interested.  The spectrum displayed will be the spectrum closest in retention time to
the click.  If the Spectrum window is already on display, the selected spectrum will
either

• Be added to the one currently on display.

• Replace the one currently on display if the  Spectrum Toolbar button is
activated.

• Be displayed in a new document window of its own if the  Spectrum Toolbar
button is activated.

n To Remove Spectra and document windows

To remove a particular spectrum, click on the spectrum with the mouse to make it
the currently selected spectrum and press the DELETE key.  You will be prompted
to confirm the deletion, press OK to confirm the delete.

To close a particular Spectrum document window press the Windows close button
x at the top right hand corner of the document window.
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Displaying Chromatograms

There are several ways in which you can display the Chromatogram window:

n To select Chromatogram using the MassLynx menu

Choose Chromatogram from the View menu or press the  toolbar button.
The chromatogram displayed will be the Total Ion Current (TIC) chromatogram of
the current data file (unless Mass Chromatogram has been selected on the System
Globals page and the files selected contain MUX data.  See page 54 for details).  If
the Chromatogram window is already on display it becomes the current window.

n To select Chromatograms using the Sample List

If whole rows are selected in the Sample List editor, Chromatograms from the data
files represented by these rows will be displayed.

n To select a Chromatogram from Spectrum

Double click on the spectrum at the mass of interest.  The chromatogram displayed
will be the mass chromatogram of the mass indicated by the click.

If the Chromatogram window is already on display, the selected chromatogram will
either

• Be added to the one currently on display.

• Replace the one currently on display if the  Chromatogram Toolbar button
is activated.

• Be displayed in a new document window of its own if the  Chromatogram
Toolbar button is activated.

n To Remove Chromatogram traces and document windows

To remove a particular chromatogram trace, click on the trace with the mouse to
make it the currently selected trace and then press the DELETE key.  You will be
prompted to confirm the deletion, press OK to confirm the delete.

To close a particular chromatogram document window press the Windows close
button x at the top right hand corner of the document window.
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The Header Editor

The Header Editor is used to determine what information is displayed in the header
for each of the MassLynx program windows.  The Header Editor can be accessed
from most of the MassLynx program windows by double clicking on the Window
header with the left mouse button or via the Header button in the Display View
dialog box.

Figure 1.25 The Header Editor

The MassLynx Window Header can be thought of as a table that has 6 rows and 3
columns.  Various pieces of information can be displayed in the header including
your own text.  Information can be displayed on lines 1 to 6.  On each line
information can be displayed in three positions, left, center or right.

At the top of the Header Editor dialog there is a graphical representation of the
current header.  The Header Editor areas that are currently displaying information
are shaded in gray.  A maximum of eight areas can be used at one time to display
header information.

n To add information to the displayed header

1. Select the Header Area in which you wish to display information by clicking
on the area with the left mouse button.

2. Select the Group, from the drop down list, that contains the information you
wish to append to the displayed header.

3. Highlight the information required in the Element list box.  Highlight the
field before which you wish to insert the information in the Format box and
choose the Add button.  To add information at the end of the currently
displayed information, highlight End and choose the Add button.
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4. To add your own text to the header select [Text] in the Element list box and
choose the Add button.  The User Text dialog will appear, type your text and
choose the OK button.  Your user text will be shown in the Format list box
and will be displayed in the header when you leave the Header Editor dialog.

5. If you wish to format the information in the header, highlight the relevant
field in the Format box and choose the Format button.  For numeric
information you can select the number of decimal places displayed in the
range 0 to 6.

Figure 1.26 The Header Editor Format dialog

6. Repeat steps 1 to 5 as required.  A maximum of eight areas can be used at
one time to display header information.

7. Choose the OK button to exit and save the changes.

Note:  If the information in one of the Header Editor areas overlaps another area,
the overlapped area will not be displayed.

n To remove information from the displayed header

1. Select the Header Area from which you wish to remove information by
clicking on the area with the left mouse button.

2. To remove a single field, highlight the information you wish to remove in the
Format list box and press the Remove button.  To remove all the
information from one Header Editor area, select the area and press the Clear
button.  To remove all information from all Header Editor areas choose the
Clear All button.

3. Repeat steps 1 and 2 as required.

4. Choose the OK button to exit and save the changes.
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Printing Data

MassLynx prints data using the Windows NT Print Manager so any printing device
supported by Microsoft Windows NT can be used with MassLynx.

All of the operations involved in setting up your printer are controlled by Windows
NT and are fully covered in the Microsoft Windows NT System Guide.  The only
MassLynx specific procedures to learn are those involved in selecting what to print.

The printer can be set up either using the Printer Setup command found in each
MassLynx File menu, or by using the Windows NT Print Manager.

n Printing a specific MassLynx window using the Toolbar

Many of the MassLynx Windows have Print buttons on the Toolbar.

  Press to print current window in portrait format.

  Press to print current window in landscape format.

n Printing a specific MassLynx window using the menu

To print a specific MassLynx window using the menu commands, select the
Window you wish to print and choose Print from the window’s File menu.

Figure 1.27 File Print dialog

All Windows  Select this radio button to print all document windows on display.

Current Window  Select this radio button to print only the currently selected
document window.

Trace Width  From the drop down list box, select the thickness of the line used to
print chromatogram traces or spectral peaks.  Trace Width can be set to values
between 1 and 5, a higher value will give a thicker line.
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Print All Colors Black  Check this box to map all the colors in the MassLynx
display to black.  This option is useful when using black and white printers.

Window Commands

Most of the MassLynx program windows have a top level menu command called
Window.  The subcommands of Window help you to organise the document
windows of that program so that they fit conveniently into the main service
window.  The Window commands are also available on many of the MassLynx
Toolbars.

Toolbar
Button

Menu
Command

Function

Tile Arranges open windows side by side on the
screen, dividing the available space equally
between the open windows so that all of them
are visible.

To arrange the windows in a particular order,
click on the title bar of each window in turn
to make it the active window before selecting
the Tile command.  The windows will be
tiled in the order in which they were selected
with the most recently selected window first.

Cascade Arranges document windows so that the title
bar of each window is visible.

Stack Arranges documents vertically above each
other.

Arrange icons Arranges all iconised windows into rows.

Window list Gives a list of available windows.  The
currently active window has a tick next to its
name.  Clicking on another window will
make that the currently active window.  In
the case of Spectrum and Chromatogram
this becomes a list of the traces displayed in
each window.

Window
New Trace
Replace Trace

Choosing this option causes each subsequent
trace to replace the currently selected trace.

Window
New Trace
New Window

Choosing this option causes each subsequent
trace to be displayed in a new window.

Window
New Trace
Add Trace

Choosing this option causes each subsequent
trace to be added to those displayed in the
current window.
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Getting Help

The MassLynx Help system contains detailed information on how to use MassLynx.
Most of the information in this manual is available on-line while you are using
MassLynx by accessing the Help system.

MassLynx Help can be accessed either from the MassLynx top level menu or from
any of the MassLynx program windows.  It can also be accessed by selecting the
MassLynx NT User Guide icon in the MassLynx group.

If you enter Help from the MassLynx top level menu you will be given a general
index of topics covering the whole of MassLynx.  If you enter MassLynx Help from
one of program windows you will be given help on that particular topic.  For
example if you choose Help from Spectrum you will be given Help on Spectrum.
MassLynx Help also allows you to search for Help on a specific topic or keyword.

For more information on using Windows Help systems you can choose Using Help
from the Help menu on the MassLynx window.  This topic gives detailed
instructions on how to use Windows Help systems.  Alternatively you can refer to
the Microsoft Windows NT System Guide.

The About Box

The About box gives you information about MassLynx, including the version
number.

Figure 1.28 The About Box

Micromass on the Web

The Micromass Web site address is http://www.micromass.co.uk it can be
accessed as normal through your internet browser or by selecting  Micromass
Home Page from the Micromass on the Web option on the top level Help menu.


